
 
PDFBlaster Installation Overview 

 
Step 1

 
If you downloaded the PDFBlaster setup file (pdfblaster.exe) from the Internet, locate where you 
downloaded this file and then double-click on it to begin the installation process. 

If you are installing from CD-ROM, the installation program is located in the root folder of the 
CD. Again, double-click on it to begin the installation process.  

The first screen that appears is the PDFBlaster license agreement. Click [Yes] to accept the license 
agreement terms and proceed. 

 

Step 2
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The next step is to select the destination folder for the PDFBlaster application. You can accept the 
default path given or you can click the [Browse] button to select a custom path.

 

Step 3

 
At this point the setup program has enough information to start copying the necessary files to your 
hard drive. 

By default setup will copy shortcuts to the PDFBlaster control panel to our Windows Start Menu 
and Startup folder so PDFBlaster will automatically start in the system tray the each time you start 
Windows.  

Click [Next] to continue.  

(Note: Depending on the current state of your system, you may have to reboot after the 
PDFBlaster Control Panel installation is completed. If you are prompted to reboot your system, 
please do so before continuing on to the next step). 

 

Step 4

 
The first time you start the PDFBlaster Control Panel (or if you have just rebooted your machine) 
the software will check to see if the PDFBlaster printer driver has been installed. 

If the printer is not found you will receive a message asking if you want to install the printer now. 
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Configuring The PDFBlaster Control 

 

Click [Yes] to install the printer or click [No] to install at a later time. If you are installing 
PDFBlaster on a Windows NT/2000/XP machine you will need to be logged on with local 
Administrator rights in order for the printer driver to be installed.  

(Note: PDFBlaster will not run correctly unless the printer driver has been installed).  

At this point, all the necessary software is installed and you are ready to configure your 
PDFBlaster Control Panel options. 

 

Step 1

 
Before you can start sending fax or email PDFs you must correctly configure the Control Panel 
Settings. Settings are automatically saved when you exit the program or when you click the 
"Save" option from the File menu. 

Send Rule 
The send rule option sets the default method that you will send your documents. PDFBlaster will 
automatically attempt to determine the contact information of the print job (which includes the fax 
number and email address). The send rule option you select will have a direct impact on those 
recipients where either the fax number or email is not on file. If PDFBlaster cannot send your 
print job using the defined send rule, the document will be automatically returned to you via email 
with a message saying the job could not be delivered. So, depending on the completeness of the 
information of your contact database, most likely one of the available send rules will be best-
suited for your document delivery strategy.  

Use email if present, otherwise use fax number: 
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Select this option if you want to send your documents as PDF attachments to recipients where the 
email address is on file, otherwise, try to use the fax number on file. 
Use fax number if present, otherwise use email: 
Select this option if you want to send your documents as laser-quality faxes to recipients where 
the fax number is on file, otherwise, try to use the email address on file. 
Always send as fax 
Select this option to always send your documents as faxes, regardless of the status of the email 
address on file 
Always send as email 
Select this option to always send your documents as email attachments, regardless of the status of 
the fax number on file 
Test Mode 
Select this option to practice using PDFBlaster before "going live". When the Control Panel is set 
to Test Mode, all document transmissions are set via email to your email address instead of the 
actual recipients. The email you receive will include the document as a PDF attachment and the 
body of the email message will contain information on where and how the document would have 
been sent had you not been in Test Mode.  

Once you are comfortable using PDFBlaster you can turn off Test Mode and set the print rule to 
the actual mode you want to use when you "go live". 

 

Step 2

 
Accounting Link Settings 
To link to a specific accounting system, click the "..." (Browse) button to select the root folder of 
where your accounting system is installed. This can be a network directory or a local directory. 
Then type in the unique company identifier in the Company ID field to tell PDFBlaster which 
accounting company you want to use.  

Optionally, if you are connecting to a SQL database, you will need to enter your login settings 
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instead of the path information described previously.  

After you enter the System directory and the Company ID (or entered your login settings), it's a 
good idea to test your connection by clicking the Test Link button. If you receive an error, please 
verify that your path setting and company ID is correct and try again or contact your PDFBlaster 
VAR or system administrator for more help. 

 

Step 3

 
Email/Fax Settings 
These options will be used by PDFBlaster when delivering your documents and returning un-
deliverable documents to you. 
From Name 
Enter your name in this field. This value will appear in the "From" part of your emails and fax 
cover sheets 
From Email 
Enter your email address in this field. This value will appear in the "From Email" part and is not 
used during fax transmissions. 
Cover Page 
By default, PDFBlaster ships with a basic cover page in RTF format that you can use with your 
faxes. Cover pages are not sent with email jobs. 

You can edit the cover page look and feel using a standard word processing program such as 
Microsoft Word. Just be sure to make a backup copy first! 
Omit Cover Page On Faxes 
Check this box to exclude cover pages with your fax jobs.  

Please note: it is extremely important that you enter a valid email address in the From Email 
field. Otherwise, Test Mode document deliveries and any un-deliverable documents and 
send confirmations will not be returned to you correctly. 
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How PDFBlaster Prints Various Documents 

 

 

Step 4

 
SmartFind Options 
PDFBlaster has a number of convenient send options that allow you to control how the software 
will process your print jobs. 

Send print jobs automatically as they are received 
Select this option to have PDFBlaster automatically process your print jobs as they are sent to the 
outbox by the Control Panel. Automatic sends work only with supported PDFBlaster accounting 
documents. Custom jobs or reports will remain in the outbox until you send them manually. 
Send Each Job Individually 
Select this option to have your print jobs queued into your Outbox where they will wait until you 
select a job and click the "Send Now" button. 
Use Default Recipient Data Select this option to tell PDFBlaster to use the recipient data derived 
from the linked customer or vendor file of your linked accounting system. 
Confirm Each Job Select this option to display a confirmation dialog that displays the recipient 
information, subject and body of the email or fax as well as additional CC options. You can 
override the default recipient data pulled from your linked accounting system from this screen. 
Please note, this option is not available if you select the [Unattended Send] mode.  

 

Step 1
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If you are running a version of PDFBlaster that links to a specific accounting system, it is 
important to understand how PDFBlaster prints different types of documents. 

By default, PDFBlaster supports the following accounting documents: 
1. Invoices 
2. Packing Slips 
3. Sales Orders 
4. Bids 
5. Pick Tickets 
6. Purchase Orders 
7. Customer Statements 

When we say "supports" we mean that when you print one these document types, either 
individually or in batch mode, and then send the document, PDFBlaster will automatically 
determine who the recipient of the document is and either email it as a PDF attachment or fax it as 
a laser-quality Internet Fax depending on the Print Rule you have selected and the data stored in 
the customer/vendor database.  

You are by no means limited to using PDFBlaster for these supported documents -- PDFBlaster 
can send print jobs from any Windows application as well as other standard reports generated by 
your linked accounting system.  

These "custom" print jobs will not have their recipients automatically determined by PDFBlaster. 
Instead, you will have the opportunity to select a recipient from one of the following sources when 
you attempt to send this document:  

1. Customer File 
2. Vendor File 
3. Customer Ship-To File 
4. Manual Recipient 
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5. Custom Query  

Let's walk through the steps required to send "supported" accounting documents and "custom" 
documents... 

 

Step 2

 
In the following example, notice that there are four different print jobs waiting in the outbox. First, 
we will send the Invoice. 

Click on the Invoice Job then click the "Send Now" button. 

 

Step 3
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Notice that PDFBlaster automatically determined the recipient of the invoice, uploaded the print 
job, and sent it to "Robert Goodman" at International Business Machines 

(In all of these examples, PDFBlaster was set to test mode so the documents were not delivered. 
Instead they were returned to the default user. Had PDFBlaster been set to a Print Rule other than 
"Test Mode" the document(s) would actually be faxed/emailed accordingly.)  

Now return to the outbox and click on the Statement Job. Then click the "Send Now" button.  

 

Step 4
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Notice that the customer statement was automatically delivered to Mark Stone at Phoenix 
Computers. 

Now return to the outbox and click on the Purchase Order print job. Then click the "Send Now" 
button. 

 

Step 5

 
Notice that the purchase order was automatically delivered to Angelo DiMaggio at International 
Data System. 

Now return to the outbox and click on the "Custom" print job, which in this case, is an HTML 
document. Click the "Send Now" button to continue. 

 

Step 6
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Now things are a little different than before. Since this is a "custom" print job PDFBlaster needs to 
know the data source you want to use in order to send the document. 

Notice that your options are: 
1. Customers 
2. Customer Ship-To's 
3. Vendors 
4. Manual Recipient 
5. Custom Query 
When you click on the "Customers" Source you will see a list of customers pulled from your 
accounting system.  

Now click on "Customer Ship-To's" to see a list of Customer Ship-To recipients. 

 

Step 7
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Now click on "Vendors" to see a list of available vendors

 

Step 8

 
Now Click on "Manual Recipient" to see the data entry form for a manual recipient. 

This is where you have the option of sending the custom print job to a recipient who is not in your 
accounting system database, perhaps a co-worker or marketing assistant. 

 

Step 9
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Now click on "Custom Query" to see a list of your defined custom queries. Custom queries are 
pre-defined data sets, based on your accounting database, that allow you to group together and 
select a specific subset of recipients from your database using data stored in specific fields. 

 

Step 10

 
In this example, we've set up a custom query for "All AR Customers", which is a list of every 
customer in our accounting system. 

Click on the "All AR Customers" custom query and, just to be sure this is correct data set, click 
the "Test Query" button to retrieve the records for previewing. 

 

Step 11
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PDFBlaster will retrieve the records defined by your query from your accounting database. 
Depending on the size of this file this may take a few seconds. 

When you select a custom query, this means that your custom print job will be delivered to all 
recipients in the result set.  

Click the "OK" button to continue. 

 

Step 12

 
You now have one more chance to actually confirm that this is the correct recipient. If you're not 
sure, you can click "No" to return to the custom query screen. 

Click "Yes" to continue.  
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Using The PDFBlaster Outbox 

 

PDFBlaster will now upload your print job and send it to all recipients in your custom query, 
using the defined send rule from your settings tab.  

 

Step 1

 
When you print documents to the PDFBlaster Printer your print jobs are stored in the Outbox. If 
your send setting is set to "Unattended Send" PDFBlaster will handle the delivery of your print 
jobs automatically. 

If your send setting is set to "Send on demand" you will have to send each job manually.  

Please note that you must be connected to the Internet to send your print job using 
PDFBlaster. 

 

Step 2
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First, click on the print job you want to send. Then click the "Send Now" button. 

Alternately, you can double-click on the selected print job to start the send sequence. 

 

Step 3

 
PDFBlaster will attempt to contact the master server. If you want to cancel you print job, click the 
[Stop Send] button now. Otherwise, the program will upload your print job to the master server.
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Creating Custom Queries 

 

Step 4

 
After the file upload is complete, PDFBlaster will deliver the document, and remove it from the 
outbox (after the next screen refresh, or you can manually refresh the outbox list by clicking the 
[Refresh Now] button). 

You will then receive a confirmation in the send log results pane. You can clear the results pane at 
any time by clicking the [Clear Results] button or print the send log data by clicking the [Print 
Log] button.  

To send another print job, return to the outbox tab and follow these same steps. 

 

Step 1
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Please Note: The Custom Query tab and Word Blast! tab may not be available depending on 
your linked accounting system. 

Creating and maintaining "custom queries" inside of PDFBlaster is a very powerful feature that 
allows you to quickly distribute documents to pre-defined lists of recipients on a recurring basis. 
Better yet, PDFBlaster supports virtually any ODBC-compliant data source in addition to any 
linked accounting database (if applicable). Using the custom query feature, you can maintain 
groups of recipients from both inside your accounting system and from external sources such as 
lead lists, contact manager databases (such as GoldMine and ACT!) or any other data source that 
contains contact information.  

In this example, we are going to create a custom query that contains all customers in our linked 
accounting system with balances greater than zero (that is, customers who owe us money!  

To begin, click the [Custom Query] tab on the PDFBlaster Control panel. Then, click the [New] 
button to begin creating your new custom query. 

 

Step 2

 
Type in a name for your new query. In this example we want to create a custom query containing 
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all customer records where open balances are greater than zero (in other words, people who owe 
us money!). 

Type in "Customers with open balances" in the input field.  

Then click the "OK" button. 

 

Step 3

 
Next, select the data source from the drop-down list. This drop-down will contain a list of all the 
ODBC data sources you have defined on your system, as well as an option to use the "linked 
accounting system". 

In our example, we have previously linked PDFBlaster to ACCPAC Pro Series, and since our 
custom query is going to retrieve all records in our accounting system where the balance is greater 
than zero, we'll select "ACCPAC Pro Series" as our data source. 

 

Step 4
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You will have to know basic SQL for this step, and it helps if you know the field structure of your 
customer/vendor database. If you need help writing the SQL for your custom queries, contact your 
PDFBlaster reseller or email PDFBlaster tech support. 

In our example we'll type the following SQL statement that will retrieve those customer records 
that have a positive balance:  

select * from arcust99 where balance > 0  

 

Step 5

Page 20 of 51

6/19/2003http://www.datafabrication.com/admin_printHelp.asp



 
Click [Test Query] button to test the syntax of your SQL and retrieve your records. If you get an 
error message, most likely your SQL syntax is incorrect. Please verify that your SQL is valid and 
click the [Test Query] again to resolve the problem.

 

Step 6

 
PDFBlaster will retrieve your data. Depending on the size of your database and the number of 
records in your custom query, this step may take a few minutes. You can check the status by 
watching the status bar at the bottom of the screen. 

When the query execution is complete, the resulting recordset will be previewed in the query 
results dialog box like the one shown above.  

 

Step 7
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Now you're ready to map your customer fields so that PDFBlaster knows how to send documents 
to them the recipients in your custom query. Click the dropdown next to each field in the "Field 
Mappings" pane and set the correct field to it's PDFBlaster counterpart. In our example:  
 
the custno field is the key field 
the contact field contains the contact's name 
the company field contains the company name 
the email field contains the email address and 
the faxno field contains the fax number. 

Click "Save" to save your query. You'll now be able so select this new custom query titled 
"Customers with open balances" as a recipient list each and every time you want to do a fax or 
email broadcast.  

(Note: only the fields highlighted in bold are required fields. In this example, the customer 
database does not contain specific fields for first name and last name so we'll just leave the field 
mappings blank. 

 

Step 8
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PDFBlaster Advanced Options 

 

 
Once your field mappings have been assigned, click the [Save] button to save your custom query. 

You can now use this query any time you want to deliver an email or fax broadcast to those 
customers whose balance is greater than zero! 

 

Step 1
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PDFBlaster includes some convenient additional configuration options that you may find useful. 

To access the advanced options screen select [Advanced Options] from the Edit menu on the 
PDFBlaster Control Panel 

 

Step 2

 
Disable Reseller Branding  
Your PDFBlaster software may be linked to your reseller's Web site in order to inform you of 
timely marketing or technical support information. If your reseller has done this you will see a 
small logo in the lower left of the PDFBlaster Control Panel screen. If you wish to disable this 
feature, check this check box. 

Error Logging  
If instructed to do some from PDFBlaster technical support, you may need to turn on error logging 
by checking this box.  

Always Start Minimized  
By default PDFBlaster starts up each time you start your computer in normal screen viewing 
mode. To start PDFBlaster minimized in your system tray, check this box.  

Show Control Panel if outbox is not empty  
If there are unsent print jobs in your outbox, checking this box will force PDFBlaster to be the 
topmost window on your screen until you either send the jobs or delete them.  

CC me on all sent print jobs  
If you want to receive a copy of each fax or email job you send using PDFBlaster, check this box. 
CC'd emails will be sent to the email address identified in your Email/Fax settings on the 
PDFBlaster Control Panel.  
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Registering Your Software 

 

Allow attachments to be added to fax jobs  
Check this box if you want to enable the ability to include additional attachments with your 
accounting documents when faxing. In order to use this feature, you must set the SmartFind 
option in the PDFBlaster Control Panel to "Confirm Each Job".  

Enable PDFBlaster Toolbar for Microsoft Word  
If you want to use the WordBlast! feature in PDFBlaster, check this box. See the support topic 
regarding WordBlasts! for more detailed information.  

When finished choosing your advanced options, click the [Save And Exit] button to save your 
changes. 

 

Step 1

 
When you downloaded your copy of PDFBlaster, you should have received a 30-day trial 
activation code via email. You must enter this temporary registration code before you can 
generate PDFs and send them as email attachments during your trial period. 

The trial-license allows you to generate PDFs as email attachments for thirty days. You will not be 
able to send actual faxes during the PDFBlaster trial period. This option is available only to fully 
licensed versions of the product. Instead PDFBlaster will send your "test faxes" as email 
attachments to your email address and will include information on the who/where/when of the 
document transmission if it was being sent using the full version of PDFBlaster.  

To activate your 30-day trial license, first click on the [Help] menu on the PDFBlaster control 
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panel and then select [Software Registration]. 

 

Step 2

 
The next screen you will see is the Registration screen show above. 

Locate the 30-day trial activation code you received via email when you downloaded PDFBlaster 
before moving on to the next step. 

 

Step 3

 
Type in (or cut and paste) the trial version activation code into the dialog box provided. 

Then click the [Register] button to validate your code.  

(Note: you must be able to access the Internet from your computer in order for validation to 
work). 

 

Step 4
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Checking For Program Updates 

 

 
If you receive an error dialog like the one shown above, most likely you typed in your activation 
code incorrectly. Try typing it in again or, better yet, cut and paste the code from the email you 
received and then click the [Register] button again. 

If you still get an error message, please contact PDFBlaster technical support at the email address 
provided. 

 

Step 5

 
Once your activation code has been accepted and registration succeeds your 30-day trial license 
has now been activated. 

 

Step 1
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It is a good idea to periodically check for updates to the PDFBlaster software. This can be 
conveniently done by selecting the "Check For Updates" option on the PDFBlaster Control Panel 
File Menu.

 

Step 2

 
If a program update is found you will be able to download the update program to your local hard 
drive. The download process will automatically close your PDFBlaster program so you can 
download and install the update automatically. 

Click [Save] to save the update program to your hard disk. 
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Installing The VFP ODBC Driver For Windows XP 

 

Step 3

 
It's a good idea to download the update into a temporary folder such as c:\temp. Click the [Save] 
button to begin downloading the update file from the Internet.

 

Step 4

 
The update program is much smaller than the full version PDFBlaster install program. Depending 
on the speed of your internet connection, the download process will take only a few minutes. 

When the download is complete, double-click on the pdfblaster_update.exe file to complete the 
installation of the update. 
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PDFBlaster Word Blasts 

 

Step 1

 
If you install PDFBlaster on a fresh version of Windows XP Professional you may not be able to 
connect to your accounting data when you click "Test Link". 

This is because Windows XP ships with an incompatible version of the Visual Foxpro ODBC 
driver (v 1.0.XXX). To fix this incompatibility you will need to download and install the VFP 
ODBC driver (v 6.0.XXX).  

Click Here To Download the VFP ODBC driver install program 

 

Step 1
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PDFBlaster provides a unique capability to create integrated mail merges using Microsoft Word 
(2000, XP or greater) and your accounting data. We call this feature Word Blast!, and once you 
try it, we're sure you will agree that using Word Blast! is much easier and more intuitive than MS 
Word's default mail merge functionality.  

In order to use PDFBlaster Wordblast! you'll first need to activate the PDFBlaster toolbar in 
Microsoft Word. To activate the toolbar, first click the Advanced options link on the Edit Menu of 
the PDFBlaster Control Panel.  

Please Note: in order to use Word Blast!, you'll need to defined at least one custom query using 
PDFBlaster. In our example, we have already created a custom query called 'Pro Series 
Customers' that we will use to generate a collection letter.  

 

Step 2
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Check the [Enable PDFBlaster Toolbar for Microsoft Word] checkbox and then click [Save 
and Exit].

 

Step 3

 
Now start Word. You'll notice a new toolbar has been added. This is the PDFBlaster toolbar.

 

Step 4
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The PDFBlaster toolbar has a quick and easy menu that enables you to drop form fields onto your 
document. 

Click The Fields... button and then select the Company field, which will add a field called 
"COMPANY" to your document. 

 

Step 5

 
Add any remaining fields you wish using the same process described in the previous step. 

In our example, since we're creating a collection letter, we're going to add some text reminding the 
customer to pay their outstanding balance. 

 

Step 6

Page 33 of 51

6/19/2003http://www.datafabrication.com/admin_printHelp.asp



 
Now you're ready to send your WordBlast! to a group of recipients defined in one of your custom 
queries. 

Click the [Send] button to continue.  

 

Step 7

 
The PDFBlaster toolbar will display a form with 3 tabs. The first tab lets you define your send 
rule, email/fax settings (along with a cover page option) as well as the subject and body of the fax 
cover page or email. 

The settings here are similar to those found in the PDFBlaster Control panel.  

Type the words "Past Due Balances" in the subject field. 
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Step 8

 
Now click the Recipients tab and select the custom query "Pro Series Customers". 

Notice that the PDFBlaster toolbar retrieved the data from your custom query and positioned the 
record pointer at the first record. 

 

Step 9

 
WHen you click the [Send Button] PDFBlaster will automatically perform the necessary field 
substitution on your letter and send the document according to your selected send rule. 

Click the [Send] button now to send your WordBlast! 
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Configuring The PDFBlaster Printer For Exact ES 

Step 10

 
PDFBlaster will display your send progress in the lower left hand area of the screen. You can 
cancel at any time by clicking the [Cancel] button.

 

Step 11

 
At the completion of your WordBlast! you can view the send log to see the results. 

It's that easy! 
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Step 1

 
The default report forms that ship with Exact ES use the Verdana font, which is not supported 
directly by the PDFBlaster Printer. 

Fortunately, it's easy to change the font handling of the PDFBlaster printer so that the program can 
automatically process your Exact ES print jobs.  

The first step is to open the PDFBlaster Printer from the Start Menu -> Control Panel -> Printers 
section.  

Click on the [Printer] menu then select [Properties] 

 

Step 2
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Next, click on the [Device Settings] tab and then expand the [Font Substitution] menu tree.

 

Step 3
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Scroll down the list until you get to the font section that lists the Verdana fonts. By default, these 
fonts are set to [Download as Soft Font]. This is the setting you will need to change for each of the 
4 Verdana font entries.

 

Step 4
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Click the dropdown and change the Verdana fonts to the following substituted fonts: 

Verdana -> Helvetica 
Verdana Bold -> Helvetica-Bold 
Verdana Italic -> Helvetica-Oblique 
Verdana Bold Italic -> Helvetica-Bold Oblique 

 

Step 5
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Linking PDFBlaster To Progression Series SQL 

 

 
Your font substitution table should match the screen above. 

To finish, click the [Apply] button and then [OK] to exit.  

You will now be able to print Exact ES documents to the PDFBlaster Printer driver correctly. 

 

Step 1
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When you start PDFBlaster for the first time, the software is not linked to any particular 
accounting system. To link to Exact Progression Series, click on the Settings tab and locate the 
section called [Link Settings]

 

Step 2

 
Select Macola Progression Series from the drop-down list of available accounting systems.

 

Step 3
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Next, Click the [Login Settings] button to display the screen where you will need to enter your 
login information in order to connect to your Macola SQL Server database.

 

Step 4

 
Depending on your system configuration the values entered in the login settings screen will be 
different. The basic premise is to define the name of the SQL Server running either on your 
network or locally. If you are running a local copy of SQL Server, type in "local" for the server 
name. Otherwise, type the name of the SQL Server on your network. 

The next step is to enter the name of the Macola database itself. For demo systems this is typically 
"demodata". For live systems this is most likely different. You may need to consult with your 
network administrator to obtain the name of the SQL Server database that stores your Macola 
Progression data.  

Next, type in a user name and password that has rights to connect to the SQL Server database. 
This can be the default Macola user name and password or another defined login that your 
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database administrator set up. In our example, we will be connecting using the administrator login 
"sa" and password "password".  

For Progression Series, you should leave the "Use Integrated Windows Security" checkbox 
unchecked because Progression does not support this feature.  

Click [OK] when finished entering you login settings. 

 

Step 5

 
Now it's time to test the login settings you just entered. Click the [Test Link] button to execute the 
test sequence. If the test was successful you will receive a message in the status bar saying "Test 
Succeeded!" 

If your test fails, please check with your network administrator or database administrator to make 
sure your login settings are correct and try again. 

 

Step 6
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After your link test is successful, PDFBlaster will retrieve the company name and pre-fill it in the 
"From Company" field. 

Now you'll need to enter the remaining "Email/Fax Settings". These settings will be used for faxes 
and emails to indicate who the document is coming from as well as to provide a return email 
address for transmission confirmation emails and/or failures. Make sure you enter in a valid email 
address or you will not be able to receive these important notices. 

 

Step 7
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The last step is to register your PDFBlaster software so you can start sending faxes and emails. 

You should have received an activation code from your reseller. You will need this code in order 
to register your software.  

Click the Edit -> Software Registration menu to begin the registration process. 

 

Step 8

 
Enter the activation code provided to you and click the [Register] button. 

Please note that you must be able to access the Internet in order for registration to succeed. 

 

Step 9
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Printing To PDFBlaster From Exact Progression Series 

 

Registration takes only a few seconds. You will receive a message saying "Registration 
Succeeded" which indicates that your software is now registered. 

If you receive a registration failure message it could be because PDFBlaster could not access the 
Internet, your registration code was entered incorrectly or your registration code is not valid for 
the linked accounting system you selected. Check with your reseller to resolve this situation, or 
contact PDFBlaster support at support@pdfblaster.com 

 

Step 10

 
Your software is now registered and linked to Macola Progression Series. At this point you can 
start faxing or emailing in live mode.

 

Step 1
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PDFBlaster can easily fax or email documents created from inside Macola Progression Series. It is 
important to note that PDFBlaster can only be used with the graphical report forms that ship with 
Progressions Series (Crystal Reports). You can still print text-based forms to PDFBlaster but 
batch faxing/emailing is not supported and the resulting PDF will contain text only. 

For this example, we are going to Reprint posted invoices using the Crystal Reports form. Click 
on Order Entry -> Trx -> Invoices/Cash and then select the "Reprint Posted Invoices" Crystal 
Reports version menu link.  

(Make sure the PDFBlaster Control Panel is running in the system tray before continuing). 

 

Step 2
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Select a starting document number and/or ending document number if desired, then click the [OK] 
button to continue.

 

Step 3

 
Progression will run the invoices and display them in thte Report Preview Screen. When you are 
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ready to continue, click the [Printer] Icon to send the documents to the PDFBlaster printer.

 

Step 4

 
Verify that PDFBlaster is the selected printer and then click [OK].

 

Step 5
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The print jobs will be sent to the PDFBlaster outbox and will remain there until you are ready to 
send them out. 

If you've configured PDFBlaster to pop up when it receives new print jobs, the above screen will 
be displayed automatically. Otherwise, double-click on the small PDFBlaster icon in the system 
tray to activate the PDFBlaster Control Panel.  

At this point you're ready to send the print jobs according to your send rule. You double-click on a 
specific job and, if you've set up PDFBlaster to "Confirm Each Job" you'll get to verify the send 
data (see the next screen). 

 

Step 6

 
The Print Job Details screen displays the recipient data of current print job. This data is pulled on 
the fly from the Progression database. You can accept the information as is, edit it, or add to it. 
You can also change the send rule in the drop down if you want to override your global send rule 
setting. 

Click [OK] to send your print job! 
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